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MAIN STREET QUARTERLY NEWS
US EDITION

Learn how to use the Document Builder to create documents and images 
to promote a new season, product launch, or your current specials!

CONSULTANT ORDER FORM
Retail price changes, additions
and discontinued items dated:

May 16, 2025 to  Sep 15, 2025Experience the easiest road to 
successful business management 

Access this and previous Product Update newsletters from inside your Boulevard program by going to the Window menu, select Shortcuts, then click on Product 

Newsletters. If you'd like to print or download a pdf copy, hover at the bottom of your web browser and click  (Download PDF).

https://mainstsoftware.zendesk.com/hc/en-us/articles/218743378-Product-Update-Newsletters
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PRODUCT CATEGORIES & DISCONTINUED ITEMS
Categories included for the current order form and discontinued 
products moved to the Last Chance / Discontinued Items product 
category

04

NEW ITEMS & CHANGES
New retail items (Limited /Special Edition and Regular Line) released 
with the current order form and price changes

SPOTLIGHT FEATURE
Learn more about documents and images you can tailor to promote 
new product launches and more from the Document Builder.05

CONTENT

Check out the webinar replays covering
New User Essentials &  

Inventory Management

Boulevard 2026 will launch on
August 8, 2025! 

Contact us by June 1 if you have time and would 
like a sneak peek and beta test the new version.

https://blvd.mainstsoftware.com/events/
https://blvd.mainstsoftware.com/events/
https://mainstsoftware.zendesk.com/hc/en-us/requests/new
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Part # Description Old Price New Price

Customized Skin Care

10190660 Indulge Soothing Eye Gel $18.00 $20.00

10203701 Hydrogel Eye Patches, pk./30 $40.00 $44.00

10098324 White Tea & Citrus Satin Lips Set $22.00 $26.00

10138754 Satin Lips Shea Butter Balm $12.00 $14.00

10186363 Satin Lips Shea Sugar Scrub $12.00 $14.00

Body & Sun Care

10088632 White Tea & Citrus Nourishing Shea Cream $12.00 $14.00

10156069 Fragrance-Free Nourishing Shea Cream $12.00 $14.00

All Matte & Luminous 3D Foundations $25.00 $26.00

Eyeliners, Mascaras & Brows

10085704 Jet Black Gel Eyeliner with Brush $20.00 $22.00

 Brushes, Applicators, & Palettes

10143940 Travel Roll-Up Bag (unfilled) $36.00 $40.00

10107305 Essential Brush Collection $56.00 $60.00

10122320 All-Over Powder Brush $16.00 $18.00

10122321 Cheek Brush $14.00 $16.00

Supplies, Packaging, & Literature

10251630 The Look (Summer 2025) $4.50 $5.00

10251631 La Imagen (Verano 2025) $4.50 $5.00

Price Changes

ADDED TO PRODUCT CATEGORY: 
SUMMER 2025
MKMEN PRODUCT LINE

•	 MKMen Regimen*
•	 MKMen Daily Facial Wash
•	 MKMen Moisturizing Shave Cream
•	 MKMen Ultimate Moisturizer

EAU DE PARFUM PRODUCT LINE

•	 Confidently You Eau de Parfum

LIMITED/SPECIAL EDITION PRODUCT LINE

•	 Lavender & Coconut Scented Shower Gel
•	 Lavender & Coconut Scented Body Lotion

BEAUTY THAT COUNTS PRODUCT LINE

•	 Berry Tinted Lip Oil
•	 Blush Tinted Lip Oil

MOVED TO PRODUCT CATEGORY: 
CUSTOMIZED SKIN CARE
MARY KAY PRODUCT LINE

•	 Nourishing Oil

MOVED TO PRODUCT CATEGORY: 
BLUSHES, CONTOURS & HIGHLIGHTERS
LIMITED/SPECIAL EDITION PRODUCT LINE

•	 Golden Glow Highlighter

MOVED TO PRODUCT CATEGORY: 
EYELINERS, MASCARAS & BROWS
MARY KAY PRODUCT LINE

•	 Great Heights Mascara

LIMITED/SPECIAL EDITION PRODUCT LINE

•	Blonde Brow Kit
•	Brunette Brow Kit
•	Dark Brunette Brow Kit

MOVED TO PRODUCT CATEGORY: 
BODY & SUN CARE
SUN CARE PRODUCT LINE

•	After-Sun Replenishing Gel
•	Sunscreen Broad Spectrum SPF 50

* Can be split into the individual part numbers. See Split Sets into Individual Items for more information.

https://mainstsoftware.zendesk.com/hc/en-us/articles/212228478-Split-Sets-into-Individual-Items


SUMMER 2025 NEWSLET TER - MAIN STREET SOFT WARE, INC.

4
All third-party trademarks, registered trademarks, service marks, 
and images are the property of their respective owners.

Your Boulevard Product List contains the following categories for the current order form:

SUMMER 2025
TIMEWISE
MIRACLE SETS
TIMEWISE REPAIR
MARY KAY SKIN CARE
CLINICAL SOLUTIONS
CLEAR PROOF
MKMEN
CUSTOMIZED SKIN CARE
FLAWLESS FACE
MATTE 3D FOUNDATIONS
LUMINOUS 3D FOUNDATIONS
SILKY SETTING POWDERS
SHEER MINERAL PRESSED & LOOSE POWDERS
BLUSHES, CONTOURS & HIGHLIGHTERS
EYE COLORS
EYELINERS, MASCARAS & BROWS
LIP LINERS
UNLIMITED LIP GLOSSES
GEL SEMI-MATTE LIPSTICKS
GEL SEMI-SHINE LIPSTICKS
SUPREME HYDRATING LIPSTICKS
BRUSHES, APPLICATORS, & PALETTES
BODY & SUN CARE
WOMEN'S FRAGRANCES
MEN'S COLOGNE
LAST CHANCE / DISCONTINUED ITEMS
SEASONAL LOOKS & MISC.
PRODUCT SAMPLES
SUPPLIES, PACKAGING, & LITERATURE
DISCONTINUED SUPPLIES
CUSTOMER PREMIUMS
ARCHIVED PRODUCT

PRODUCT CATEGORIES

•	3-in-1 Cleansing Bar (with soap dish)
•	All Creme-to-Powder Foundations
•	Best in Brightness Bundle
•	Deep Glow Illuminating Bronzer
•	Medium Glow Illuminating Bronzer
•	MKMen Advanced Facial Hydrator SPF 30

•	MKMen Cooling After-Shave Gel
•	MKMen Daily Facial Wash
•	MKMen Skin Care Regimen Bundle
•	Protect and Refresh Bundle
•	Pure Protection Bundle

MOVED TO PRODUCT CATEGORY:  
LAST CHANCE / DISCONTINUED ITEMS

https://mainstsoftware.zendesk.com/hc/en-us/articles/360008558514-Archive-Product
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Promote new products or seasonal sales by importing various documents and images, then tailoring them with your own text, 
images, and QR codes. Some of them can even be used as-is if you do not want to customize them. 

The  Document Builder gives you the ability to save in two different PDF formats; one allows you to edit the PDF outside of 
Boulevard if you choose to, and the other option is a flattened PDF, which can be sent to your customers. 

You can also save documents as an image file (.png or .jpg), which can then be used when sending emails, text messages or added 
to the image placeholders on your invoice in Boulevard (Top Banner, Footers, or Photo).

Access from the main toolbar by selecting the  Documents button.

The product images shown in the customized examples are for demonstration purposes only and are not included in Boulevard. To use, you will need to obtain it from the 
company website or other source.

Promote New Products & Monthly/Seasonal Sales using the Document Builder

Type: Invoice Images
Category: Banner (Seasonal/Misc)
Document Name: Skincare & Bags/Gifts

Tip! 
Left-click on an image placeholder to add your own images or ones you've previously downloaded from the company website.

 Alternatively, you can right-click on the image placeholders and choose Import to add graphics from the Image Gallery.

Type: Invoice Images
Category: Banner (Seasonal/Misc)
Document Name: Product Spotlight (Style 2)

Type: Invoice Images
Category: Banner (Seasonal/Misc)
Document Name: New Products Launched (Style 1)

https://mainstsoftware.zendesk.com/hc/en-us/articles/15870973485723
https://mainstsoftware.zendesk.com/hc/en-us/articles/25772597970331-Main-Application-Toolbar
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The product images shown in the customized examples are for demonstration purposes only and are not included in Boulevard. To use, you will need to obtain it from the 
company website or other source.

Promote New Products & Monthly/Seasonal Sales using the Document Builder (cont.)

Type: Images (Misc)
Category: Miscellaneous
Document Name: Product Spotlight (Style 1)

The following documents can be used as a social media post, sent as a text message, in an email, or even printed.

Type: Images (Misc)
Category: Miscellaneous
Document Name: Product Spotlight (Style 4)

Type: Images (Misc)
Category: Miscellaneous
Document Name: Exclusive Special / Flash Sale (Style 1)
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Type: Fliers
Category: Miscellaneous
Document Name: Dads & Grads

Promote New Products & Monthly/Seasonal Sales using the Document Builder (cont.)

Create a flier using the Document Builder and either print it, save as an image or PDF, which can then be sent to your customers 
electronically (email, text, etc.). Watch the webinar replay, and for detailed steps, view the support article from the support 
center website (from the Help menu in Boulevard, select Help).

The product images shown in the customized examples are for demonstration purposes only and are not included in Boulevard. To use, you will need to obtain it from the 
company website or other source.

https://mainstsoftware.zendesk.com/hc/en-us/articles/17289997796507-Boulevard-2024-Webinar-Replay
https://mainstsoftware.zendesk.com/hc/en-us/articles/15870973485723-Create-Custom-Documents-Images


Main Street Software, Inc.
35 E Horizon Ridge Pkwy Ste 110-471

Henderson, NV 89002
(702)487-7008

www.mainstsoftware.com

UPCOMING CLOSURES:

Monday, May 26, 2025
Friday, July 4, 2025

https://www.mainstsoftware.com
https://www.mainstsoftware.com
https://vimeo.com/boulevardsoftware
https://www.instagram.com/boulevardsoftware/
https://www.facebook.com/BoulevardSoftware/


June 2025 Skin Care Promotion
The following part numbers have been added as prepacks to the Last Chance/Discontinued Items product category and will automatically split to their regular set part 
numbers.  

SPECIAL 
PART # DESCRIPTION TAXABLE

RETAIL PRICE

SPECIAL
FIXED 

WHOLESALE
REGULAR PART # DESCRIPTION

INDIVIDUAL/ 
BLENDED 

WHOLESALE 
PRICE

10247561 June 2025: Miracle Set (Normal/Dry) $116.00 $52.20 10217417 Miracle Set (Normal/ Dry) *

10247562 June 2025: Miracle Set (Combo/Oily) $116.00 $52.20 10217415 Miracle Set (Combo/Oily) *

10247563 June 2025: Ult. Miracle Set (Normal/Dry) $150.00 $67.50 10223243 Ultimate Miracle Set (Normal/Dry) *

10247564 June 2025: Ult. Miracle Set (Combo/Oily) $150.00 $67.50 10223244 Ultimate Miracle Set (Combo/Oily) *

10247565 June 2025: Beyond Ult. Miracle Set (C/O) $208.00 $93.60 10223245 Beyond Ultimate Miracle Set (Combo/Oily) *

10247566 June 2025: Beyond Ult. Miracle Set (N/D) $208.00 $93.60 10223246 Beyond Ultimate Miracle Set (Normal/Dry) *

10247569 June 2025: Clear Proof Acne System $56.00 $25.20 10058977 Clear Proof Acne System Set *

10247570 June 2025: Hydrating Regimen Set $80.00 $36.00 10230672 MK Hydrating Regimen Set (N/D) *

10247571 June 2025: Mattifying Regimen Set $80.00 $36.00 10230673 MK Mattifying Regimen Set (C/O) *

* If you would like to split the sets into the individual items included in each, see  Split Sets Into Individual Items, then use the tables on the following page to enter the 
blended split wholesale price.

Access this and previous Product Update newsletters from inside your Boulevard program by going to the Window menu, select Shortcuts, then click on Product Newsletters. If you'd like to print or 

download a pdf copy, hover at the bottom of your web browser and click  (Download PDF).

https://mainstsoftware.zendesk.com/hc/en-us/articles/8022800533531-Product-Profile-Types
https://mainstsoftware.zendesk.com/hc/en-us/articles/8022800533531-Product-Profile-Types
https://mainstsoftware.zendesk.com/hc/en-us/articles/212228478-Split-Sets-into-Individual-Items
https://mainstsoftware.zendesk.com/hc/en-us/articles/218743378-Product-Update-Newsletters


USE THE FOLLOWING BLENDED WHOLESALE WHEN SPLITTING THE SET INCLUDED IN: 

June 2025: Miracle Set (10247561) or (10247562) $52.20

PART # DESCRIPTION

BLENDED 
SPLIT 

WHOLESALE

10217406
4-in-1 Cleanser (Normal/Dry) or (Combo/Oily) $10.59

10217404

10217393
Antioxidant Moisturizer (Normal/Dry) or (Combo/Oily) $13.87

10217391

10217385 Daytime Defender Broad Spectrum SPF 30 $13.87

10217387 Nighttime Recovery $13.87

USE THE FOLLOWING BLENDED WHOLESALE WHEN SPLITTING SETS INCLUDED IN: 

June 2025: Ult. Miracle Set (10247563) or (10247564) $67.50

PART # DESCRIPTION

BLENDED 
SPLIT 

WHOLESALE

10217406
4-in-1 Cleanser (Normal/Dry) or (Combo/Oily) $10.56

10217404

10217393
Antioxidant Moisturizer (Normal/Dry) or (Combo/Oily) $13.83

10217391

10217385 Daytime Defender Broad Spectrum SPF 30 $13.83

10217387 Nighttime Recovery $13.83

10217408 TimeWise Eye Cream $15.45

USE THE FOLLOWING BLENDED WHOLESALE WHEN SPLITTING THE SET INCLUDED IN: 

June 2025: Clear Proof Acne System (10247569) $25.20

PART # DESCRIPTION

BLENDED 
SPLIT 

WHOLESALE

10233551 Clear Proof Clarifying Cleansing Gel $6.81

10056743 Clear Proof Blemish Control Toner $6.13

10095054 Clear Proof Acne Treatment Gel $4.77

10056749 Clear Proof Oil-Free Moisturizer $7.49

USE THE FOLLOWING BLENDED WHOLESALE WHEN SPLITTING SETS INCLUDED IN: 

June 2025: Beyond Ult. Miracle Set (10247565) or (10247566) $96.30

PART # DESCRIPTION

BLENDED 
SPLIT 

WHOLESALE

10217406
4-in-1 Cleanser (Normal/Dry) or (Combo/Oily) $10.89

10217404

10217393
Antioxidant Moisturizer (Normal/Dry) or (Combo/Oily) $14.24

10217391

10217385 Daytime Defender Broad Spectrum SPF 30 $14.24

10217387 Nighttime Recovery $14.24

10217408 TimeWise Eye Cream $15.90

10145950 Microdermabrasion Refine $15.07

10198715 Pore Minimizer $11.72

USE THE FOLLOWING BLENDED WHOLESALE WHEN SPLITTING THE SET INCLUDED IN: 

June 2025: MK Regimen Set (10247570) or (10247571) $36.00

PART # DESCRIPTION

BLENDED 
SPLIT 

WHOLESALE

10201304
MK Cleanser (Hydrating) or (Mattifying) $9.00

10201340

10201374
MK Moisturizer (Hydrating) or (Mattifying) $9.00

10201376

10201395 MK Exfoliating Scrub $9.00

10201384 MK Balancing Toner $9.00
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